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1. INTRODUCTION

DESCRIPTION AND FEATURES

The ShockLog Satellite Impact Recording and Tracking System combines the ShockLog 298 impact recorder and a
satellite communication module to deliver outstanding impact recording, real-time reporting and asset location.
Real-time reporting of impact alerts informs the right people when unacceptable conditions have occurred during
ajourney.

TECHNICAL SPECIFICATIONS

-30 to 60°C / -86 to 140°F
Operating Temperature Range The unit shall remain operational over the -40 to 85°C / -40 to 185°F
range but may experience battery life and RF signal degradation.

Acceleration Range +/-1to +/-200G

Amplitude Scale (Programmable) 1G, 3G, 20G, 30G, 100G, or 200G
Scale Factor Accuracy at 5G +2%

Additional Error Other Ranges +2%

Cut-off Frequency Options 10 Hz, 40 Hz, 50 Hz, 90 Hz, 120 Hz and 250 Hz

(Programmable)
Wake-up, Warning, and Alarm 5 - 95%
- (]
Threshold (% of Range)
Enclosure Rating NEMA 1, 3, 4X, 6P, 12
Size 320.3x239x119.1 mm /12.61 x 9.41 x 4.69 in
Weight 4.4kg / 9.7lbs
Satellite Technology Global LEO Satellite operation using Globalstar Simplex Data Networks
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2. INITIAL SETUP

ACTIVATING THE SHOCKLOG SATELLITE

NOTE: Activation of the satellite module can take up to 2 business days. Please plan accordingly.

If this is the first connected device purchase for your company, you must establish an account admin. This person
will be responsible for managing user access to the SpotSee Cloud.

Navigate to activate.spotsee.io to begin the activation process.

SDQJE See Enter the Customer Number found on the packing list that shipped with the ShockLog
Satellite, the SpotSee invoice or order acknowledgement.

- Enter the Unit ID found on the label on the ShockLog Satellite.
I"1" Accept the Terms and Conditions.

Click Activate.

Enter the admin email address in the pop-up box and click Enter

An email will be sent to the Admin’s email address from no-reply@shockwatch.com.
NOTE: If the email is not received within 5 minutes, please check your spam or junk folders. If it has still not been
received, please contact SpotSee technical support.

Follow the link in the email to create your password.

A message will prompt you to Your ShockLog Satellite unit has

now been activated.

the unit. Click the dropdown = T 0= _ ShockLog Satellite Activated
list to select a contract. e [ .-‘ Shockiog Satolitha has been Actvatod.

Click Activate. S

select an available contract for

Once the administrative account is established,
— navigate to cloud.spotsee.io and log in with the
Admin email and password.
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The admin can view and manage other users and assets inside the company. Clicking Users on the left side menu
displays a list of all existing users for your account.

Add a user by clicking the plus (+) sign or edit a user by clicking the pencil icon.

SD@t see Dashboard Users Q

Assets
Dashboard
Configure Unit Jane Smith
Assets
Users
Confioure Un
Configure Unit o John Brown .
Help
Add User X Edit User X
Ja;e
" Smith
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LOGIN AND PASSWORD RECOVERY

Navigate to cloud.spotsee.io and enter your email and password.

SPG

Global loT Connectivity and Cloud

If you have forgotten your password, click “Forgot Password.” Enter your email and click “Reset Password.”

An email will be sent with directions and a link to reset your password.
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POWERING THE SHOCKLOG SATELLITE

All required lithium batteries for the ShockLog and ShockLog Satellite module are installed at the factory unless
otherwise arranged with SpotSee. Batteries included are as follows:

Component Battery Type Quantity
ShockLog 3.6V AA Lithium Batteries 2
Interface Board 3.6V AA Lithium Battery 1
ShockLog Satellite Module (Internal) 1.5V AA Lithium Batteries 4
ShockLog Satellite Module (External) 3.6V C Lithium Batteries 4
| i
CAUTION - RISK OF EXPLOSION IF BATTERIES [ —

ARE REPLACED BY AN INCORRECT TYPE.
DISPOSE OF USED BATTERIES ACCORDING
TO THE INSTRUCTIONS.

External Battery
Compariment
Provides power for the
satellite module

Interface Board Battery

NOTE: Operating the ShockLog Satellite in a location without line of sight to the sky will significantly reduce the
battery life of the satellite module.
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3. SHOCKLOG SATELLITE - SHOCKLOG"®
SOFTWARE INSTALLATION

At the heart of the ShockLog Satellite system is the ShockLog impact recorder. The ShockLog must be configured
prior to using the ShockLog Satellite. It is possible to order the ShockLog with configuration already loaded into the
unit. However, it will be necessary to reprogram the unit after the device has completed its first deployment.

This section will discuss all the programming options of the ShockLog. Some options are not supported on the
ShockLog Satellite and are noted in the document.

Many IT systems prevent individual users from installing software on their machines or users may have restricted
rights. Therefore, it is essential that you consult your IT Department to ensure you have sufficient rights to install
the software. The ShockLog software has been designed to run on a standard PC under Windows XP, Vista, 7, 8, or
10. Each of these operating systems require administration rights to install the software.

To begin the software installation process, insert the USB stick into the USB port on your PC. The set-up process
should run automatically. If for any reason the set-up program does not automatically run, go to the Start menu and
in Run, enter V:\shocklogsetup.exe (where V:\ is the USB stick) and open the program from there.

Enter your name, company name and the unique serial code

Licence Key

supplied with the ShockLog. The code will begin with “SW.”
Once the appropriate information and a valid code have been User: ||
entered, click “OK.” Compary:

If Microsoft.NET Framework and Microsoft Access are not IR i | |

installed, the following steps will be executed. A new window
will appear displaying the Microsoft.NET end user license
agreement, click “Accept.”

The installation will continue and the system will install components from the CD for the Access Database Engine.
Click “Install” to continue.
Fox the takowng conponens: E ShﬂCklﬂg Setup E|

Microsoft NET Framework 4 Chent Profile [x06 and x64] The following components will be installed o pour machine:

Flaase inad the folowing Bcanse agresment Prass the page down k | -
it o momenint. T IR R0S SR Access Databaze Engine

-

MICROSOFT SOFTWARE
SUPPLEMENTAL LICENSE TERMS

MICROSOFT .NET FRAMEWORIK 4 FOR
MTCROSOFT WTRDOWS OPFRATTMNG ¥

Do yvou wizh to install these components?

3| viewEuLAfe piving [f you chooze Cancel, setup will exit.
Do you accept the terms of the pending License Agresment?

SRR Install Cancel

[ eeent | [ Deriicomt

If you chooea Dron't Accept, irtall will clocs. To inctall ou must accept ] [
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The Microsoft Access database engine installation wizard will run next. Click “Next” to continue.

Accept the Microsoft Access End User License Agreement terms.

i& Microsoft Access database engine 2010 {English) Setup @ {%¥ Microsoft Access datahase engine 2010 (Fnglish) Setup

Microsoft Aiccess database engine 2010 {English) E 51 Microsoft Access database engine 2010 (Enalish) nn
3] . w
L End-User License Agreement Ly

To continue with Microsoft Access database engine 2010 (English) installation, you must

Welcome to the Microsoft Access database engine 2010 (English) Installation accept the terms of the End-Liser License Agreement. To accept the agreement, click the

Wizard check bax below,

The Sctup Wizard will install Microsoft Access database engine 2010 {English) on your MICROSOFT SOFTWARE LICENSE TERMS A

conputer, Click Next Lo continue or Cancel to exit the Setup Wizard,
MICROSOFT ACCESS DATABASE ENGINE 2010 REDISTRIBUTABLE

These license terme are an agreement betweon Microsoft Corpor ation
{or based on where you live, one of its affiliates) and you. Please read
them. They apply to the software named sbove, which includes the
media on which you received it, if any, The terms also apply to any
Microsoft

e updates,

11 accept the barms in the License Agreament

(e ) (o] oo ) e

The Access database location is set up next. Eln  ticrosoft Access database engine 2010 (English) Setup has
EWT completed successfully,
Click “Install” to continue.

Click “OK” to complete the setup of the Access Database.

Microsoft.net Framework will install next.

i Microsoft Access database engine 2010 (English) Setup

Microsoft Access database engine 2010 {English}

Choose where to install Microsoft Access database engine 2010 (English)

Install Microsoft Access database engine 2010 (English) to:

|C:'|,F‘r0gram Files\Microsoft Office), Eron

::zj Instaling Microsott \ME | Framework 4 Llient Frohle |x65 and <b4)...

< Back ] I Install l L] ]

Cancel
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After Microsoft.NET Framework and Access have been installed, the installation of the ShockLog software will begin
automatically. A ShockLog Setup Wizard will install the ShockLog software on your computer. Click “Next” to start
the installation.

A new window detailing the end user license agreement required to utilise the software will appear. The user must
accept the terms of the software by selecting “l accept the terms in the License Agreement.” Click “Next”
to continue.

% Shocld og Satup T T

‘. End-User License Agreement
% Welcome to the Sh(]:kl_cg SetUD Wizard Mcasc read the Following licensc agrecment carcully
ShocklLog End User License Agreement ™

The Setup Wizard will install ShockLog on your computer.
Click. Mext bo continue or Cancel to exit the Setup Wizard,
THE SOFTWARE LICENCE

By installing upon your computer the Softweare supplied with the

Shnrkl ng system yon are dermed tn have read and acrepted all

the terms of this Licence and vou and your employees will be bound

by the terms of this Licence. If you do not wish to accept the terms

retum the Software in its package unopened to Lamerholm e

[711 accept the terms in the License: Agreement

[ mext | concel | pie | [ Back | rest [ cancel |

Next, another ShockLog Setup window will prompt the user for the product options to install. Verify that both
“Create a shortcut for this program on the desktop” and “Install Software Update Utility” are checked. Click
“Next” to continue.

Users can select the location of the software installation. However, it is recommended that the default settings
be accepted.

To change the directory address, either type over the information in the box or browse for the desired directory
by selecting the “Change” button. Once you have selected the desired directory, click on the “Next” button.

i Shockl og Sctup (] li=l, iz Shockl.og Setup
Product Options Selection Destination Folder
Please select the product options you wish bo install. Click Me:t boinstal to the default Folder or click Change to choose another,
Install ShockLog to:

[¥]create a shorteut For this program on the desktop.

IC:'l,ngran FilesiShockLog Software],

[l 1nctall Software Update Utiity.

[ Back ” [t Zanzel tiadk Fext | [ Lariel
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A window stating “Ready to install the ShockLog” software will appear. Click “Install” to continue.

The system will begin the installation of the ShockLog software. At this stage, several progress bar windows will
appear. A Microsoft software installation warning stating that the software has not been verified for compatibility
to Windows XP will appear. Click on the “Continue anyway” button. The same window will appear a second time.
Click on the ‘Continue anyway’ button. When asked to install Maxim and The IMC Group drivers, click “Install.”

Once the system has fully installed, a “Completed the ShockLog Setup Wizard” window will appear. Click “Finish”
to complete the installation.

i Shockd og Setup

Keady to install shockLog @

Click Install ko begin the installation. Cick Back to review or change any of your
installation settings. Click Cancel to exdt the wizard,

i Shockl og Setup

$ Completed the ShocklLog Setup Wizard

k. Uiz Finisdy ListLune Lo il Uie Selup Wicard,

[ Bak || sl | [ cancel |

The ShockLog software is now loaded and the computer should be back at the Desktop view. To create a shortcut
on the Desktop, right click on the Start menu and select the “Explore” option.

The ShockLog programs will have been copied into the following directory: c:\ProgramData\ShockLogSoftware\
ShockLog or it will be installed in the destination directory specified earlier in the setup process.

Right click on the ShockLog program icon and select “Create Shortcut.” Once the shortcut has been created, it can
be dragged onto the Desktop.

To open the ShockLog software, double click on the shortcut icon from the Desktop. When first attaching the
ShockLog unit to the PC, it will be necessary to install new USB drivers for the PC to communicate with the
ShockLog. After connecting the ShockLog to the PC via the USB cable, a “Found New Hardware Wizard” window will
appear. To the question, “Can Windows connect to Windows Update to search for software?” it is essential that the
user select “No, not this time” to prevent the system from going to the Microsoft website to find the drivers.

Click “Next” and a second “Found New Hardware Wizard” window will appear.
Select “Install the software automatically (Recommended)” and click “Next.”

A window with a Microsoft software installation warning stating that the software has not been verified for
compatibility to Windows XP will appear. Click “Continue anyway.”

solutions@shockwatch.com.au 1300 074 625 shockwatch.com.au d
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The appropriate drivers now will be loaded on the PC and will allow the ShockLog device to communicate with the
ShockLog Software.

If the drivers do not load correctly, it may be necessary to return to this window and select “Install from a list or
specific location (Advanced).” Browse the PC to find the appropriate drivers within the ShockLog directory.

If the ShockLog does not connect after successfully loading the drivers, please check that the communication ports
are correct. The port settings are found in the “Tools” menu under Communication Properties. These settings are
only relevant to legacy ShockLog products.

SHOCKLOG AUTOMATIC CHECK FOR UPDATES

The ShockLog software has a built-in facility to automatically check the internet for the latest version of software.
When installing the software, users will be given the option of enabling this feature using a check box. Should you
wish to change this option after installation, select the “Help” menu. Users can turn this on or off with the “check
for updates” option.

solutions@shockwatch.com.au 1300 074 625 shockwatch.com.au  Mar 2020



https://shockwatch.com.au

SHOECKWATICH®

Damage Prevention and Safety Solutions

ShgckLog

4. CONFIGURE THE SHOCKLOG
SATELLITE / SHOCKLOG RECORDER

If the ShockLog Satellite is preconfigured by the SpotSee team, the appropriate configuration will have been defined
at the time of order. Please contact SpotSee Technical Support with any questions.

To configure the ShockLog Satellite, the a==rmmanns s

Shocki .\Jé'-

ShockLog software can be opened by ey~ oo
double clicking the ShockLog shortcut | ===
icon or by selecting the ShockLog
program from the Start menu.

When the software first opens you
will be presented with a “File Viewer”
window in addition to a “dockable”
Explorer window on the left and
another dockable window in the
bottom of the screen containing tabs
for the Record Table and Events Table.

The ShockLog user interface has a variety of dockable windows that allow the user to view information of interest.
These windows make it easy for users to move around in the journey data files. Move each dockable window by
clicking the left mouse button and holding. Drag the window around and notice that small window icons appear at
the left, right, top and bottom of the screen. As the windows are moved closer to one of these icons, it will highlight
in green where the window will sit.

) Srcting sheccng - 10 BR80T
Bie Yook View Wedees  aip L

Moduli [g)
|
E

Ewent 39 (g)
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All dockable windows work in any position. However, the Explorer window generally works better in either of the
left/right vertical positions, whereas the Record and Event Table windows are better suited to the top/bottom
horizontal positions.

It is possible to dock more than one window in the same location. The software displays an additional icon with a
series of tabs to move between the windows.

When trying to dock two windows in the same location, icons either left and right or top and bottom of the current
window are displayed.

If one of these options is selected, both windows will be displayed side by side. This side by side display is only
possible for two windows in any one position. If attempts are made to add additional windows, the tab system
must be utilized.

When the dockable windows are in the desired locations, adjust the size of each window by dragging the border of
each window. Adjust the window size to maximise the available screen area for the File Viewer. Windows can be
moved and adjusted at any time.

(5] Shocklog: Shocklog - [4/17/2014 1:34:44 PM 20036]

File | Tools | View Windows Help

Graph and Unit Options

The position of the docked windows can be saved so
they are in the same location when exiting and entering

the ShockLog system. From the Tools menu, select Data Paths

“Save Current Settings.” Once this has been done, a Communications Port I

confirmation window will appear. Cosmpact Anstfe poic o |Setnga [ Ss .5
Export Current Record as Database 5 * | Report §f
Import Database 298
Restore Default Settings et 4/17/2014 €

For demonstration purposes, several files are included e Gl R Seings e AL

in the database installed with the ShockLog software. Res_tme S_Md i E SANELE
Unit Radio Setup B: 4/17/2014 1

These files are shown in the Explorer and Record view.
Click on one of the available files and the Summary

Read Last GPS Data
Create Edit User Setup List

10

Report will be displayed in the File Viewer. The = '4!'1!25!11.*-:44 PI:20036 8
s | =

demonstration files may be deleted at any time. Spenrl (L S

With a file open, it is possible to explore the information available from the File Viewer screen. Notice the six tabs
along the top of the viewer. Each tab links to more detailed information relating to the open file record. The
information includes:

e Reports

e Settings

¢ Slots

¢ Slot Alarms

e Summaries

¢ Events

Users can view or hide the Home tab with the “View Home Tab” option in the “View” menu at the top of the screen.
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CREATING A SETUP FILE

To create or modify a setup file, go to the “View” menu at the top of the
screen and select “Setup.” A new window will appear listing the available
ShockLog models.

The ShockLog model selected will affect the options available in the
setup screens.

It is important that the 298 be selected as it is the only model which
supports the ShockLog Satellite functionality.

To open an existing file, select the ShockLog model of interest and click
the “Load File” button. A list of available setup files related to the selected
model will be shown. Highlight the desired file and click on “Open.”

To create a new setup, click “New Setup.”

The “Current File” button allows you to interrogate a connected ShockLog
to determine what setup has been loaded into the unit.

SETUP WINDOW

SHOECKWATICH®

Damage Prevention and Safety Solutions

(5] Select Mode! (10 o[ IS

] RD411

| Loadfie |

| Curent File |

[ MNew Set-up ]

[ Cancel ]

The setup window displays a series of tabs that guide the user through the ShockLog configuration process. The
software requires that the user complete the appropriate areas. For a new setup, the system will adopt a default
setting and complete some sections. The user must step through every window and modify the settings or select
“Continue.” Guiding the user to step through every window for a new setup ensures that all the options have been

considered and reduces the chance for a setup error.
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FIRMWARE OPTIONS

The first tab in the Setup screen is “Firmware Options.” This section defines what factory or peripheral accessories are
being used with the selected ShockLog. If the options are grayed out and selected, they are default options and cannot
be changed. If they are grayed out without being selected, the options are not available for the selected ShockLog.

. Setup - 298 — ®

Fimware Options  Settings Slots Events Slot Alams T4R Alams  Finish

Standard Options Factory Options Penpherals
[] gRMS (Vibration) ] Edemal RH/T [] RD299 HPT On Wams
Extemal RH (RD317 only [C] RD4D0O Remote Accel On Alams
[] Intemal Tit Roll [C] RD401 Remote Indicator P
(] GPS Module (] RD404 Tik and Roll Reset via Btema

] RF Communications

[ shock Trak/LogLink

] Edemal iButton Password

Password:

Confim

Continue >>

STANDARD OPTIONS

gRMS (Vibration) — Users have the option to record the gRMS values within the time slot graphs, allowing users to see
the vibration levels throughout a given time slot period. When measuring gRMS, it is required that the 250Hz filter be
selected. This selection is done automatically by the software. More details on filter settings will follow.

NOTE: It is NOT recommended that vibration be monitored with the ShockLog Satellite unit as it may result in numerous
messages being generated and increased connectivity charges.

FACTORY OPTIONS

External RH/T — Relates to the ShockLog 298 and 248 with the factory optional Temperature and Humidity
sensor added.
NOTE: This accessory would result in the temperature / humidity inside the ShockLog Satellite case being measured / recorded.

External RH (RD317 only) — Relates to the Legacy RD317 Micro ShockLog with the factory optional Temperature and
Humidity sensor added. (Not supported on ShockLog Satellite)

Internal Tilt/Roll — Relates to the ShockLog 298 with the factory optional sensor added to detect tilt & roll.

GPS Module — Refers to ShockLog 298 with optional GPS module to record GPS coordinates of an impact and
coordinates when a time slot summary is made. (Not supported on ShockLog Satellite)

RF Communications — Relates to the ShockLog 298 with the factory optional ZigBee radio module being added to
transmit data files wirelessly in a stationary environment. (Not supported on ShockLog Satellite)

1300 074 625 shockwatch.com.au  Mar 2020
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PERIPHERALS

Optional accessories may be added to the ShockLog setup.

RD299 HPT — Humidity, Pressure, Temperature Sensor (Not supported on ShockLog Satellite)

RD400 Remote Accelerometer — Legacy product supported by ShockLog RD298 — recorded single access
acceleration in a location remote from the ShockLog. (Not supported on ShockLog Satellite)

RD401 Remote Indicator — Legacy product supported by ShockLog RD298 — brought alarm warning lights to a
location away from the ShockLog. (Not supported on ShockLog Satellite)

RD404 Tilt & Roll — Legacy product — external tilt and roll accelerometer (Not supported on ShockLog Satellite)

¢ ShockLog Satellite / LogLink - Accessory to provide near-real time impact notification and location information.
(SELECT WHEN UTILIZING A SHOCKLOG SATELLITE)

e External — Custom connection; discuss additional input requirements with your SpotSee representative.
(Not supported on ShockLog Satellite)

Click the box for any options that will be utilized with the ShockLog, then click “Continue.”

RD401

These settings are available for a customized legacy solution from ShockWatch. They are not supported by the
ShockLog 298, 248, or ShockLog Satellite.

IBUTTON PASSWORD

It is recommended that iButtons be used to start or stop the ShockLog Satellite.

For additional security, users may create password protection in the iButton system. These passwords prevent
unauthorised users from interfering with the ShockLog through the iButton interface. To create password
protection on the iButton interface, users program the ShockLog with their own password (up to 8 characters in
length and case sensitive). Any iButton used to communicate with the ShockLog must be programmed with the
same password. Otherwise, the ShockLog ignores the iButton.

The password is created by clicking in the Password box and typing in the password. The password is confirmed by
typing in the confirm box. The confirmation password must be exactly the same as the original password.
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SETTINGS

The Settings window allows the user to select ¥ Setwp- 298 (=] ]
. . [[ Fermuare Opbins | Settings [ Sicts | Events | Siot Alams | TR Alams | Fiish |
the protocol, create setup name, enter mission i e
diofoul] 05232176 Aor 213 @+

comment and set start date.

Misgon Commant |

SETUP NAME '

Users can name their setup and save it as a unique
file for future use. With a new setup, the word

“Default” will be in the setup name field. The user ( ey
must change this name before they are able to

save the setup, send it to a ShockLog unit or
move onto the next stage of the setup process.

NOTE: If you have a setup you want to use as the preferred setup, make this the user default by going to the options
screen, double clicking on the user default setup box and selecting your setup file name.

START DATE

If the user would like the ShockLog unit to begin monitoring at a future date/time, click on the right-hand arrow
to bring up a calendar selector and select the desired date. If the unit should start recording at a specific time, it is
possible to set the start time as required. The start time will be +/- 10 minutes of the specified start time.

NOTE: The “Start” iButton being applied to the reader port will override any delayed start and begin the recording
process. It is recommended that the START ibutton be used when starting the ShockLog Satellite. This allows the user
to mount the ShockLog Satellite prior to starting the recording process.

It is also possible to start the ShockLog sooner than the Start Date by connecting the ShockLog to the USB port and
clicking “Start” in the Communications Window. This action will override the delayed start, and the ShockLog will
begin recording immediately.

MISSION COMMENT

Users can add notes to the setup file and these notes will be recorded by the ShockLog. These comments will be
displayed on the Report screen when the file is downloaded.

PROTOCOL

Protocol 400 is the appropriate setting unless the RF module is installed and being used. If the ShockLog has an RF
modaule installed, P400 and ZigBee should automatically set. Verify the correct protocol when using the ShockLog
298 RF unit.

ShockLog Satellite uses Protocol 400.
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SLOTS

Slots are user-defined periods of time in which various criteria will be recorded.

SLOT CONTENTS

Slot contents define the criteria to be recorded in the Slots graphs. Select the parameters of interest by clicking
the appropriate boxes. The four default settings are max peak x, y, z and internal temperature. Depending on the
configuration of the ShockLog, the available slots include max/min peak for the three axes, temperature, humidity,
dew point, pressure, tilt and roll.

Setting threshold limits for these values will be done in the Slot Alarms and T&R alarms sections.

= Setup - 208 - L
| Firmware Options i Settings | Slots | Events | Slot Alamms i T&R Narrnsi Firish |
Slot Contents
[¥] Max Peak X [¥] Intemal Temperature Intemal Tilt Joumey Duration
[¥] Max Peak ¥ Extemal Temperature Intemal Roll
=il Slot Interval
|| Max Peak 2 Extemnal Humidity
= 10 Sec -
7] Min. Peak X Extemal Dew Paint
B Min. Pesk Y Max. No. / Run time:
o 93491, 10Days
|| Min. Peak 2 HPT Temperature
HPT Humidity Summary Interval
HPT Dew Poirt 10 Min -
HFT Pressure Run time
TDays, 2Hours.
Cortinue ==

SLOT INTERVAL

The Slot Interval defines how often a time slot will be recorded. The window below the Slot
Interval setting will show how long the maximum number of slots and run time based on the setting.

Battery life is not affected by time slot frequency.
It is advisable to always select a time slot interval that will last longer than the expected journey length.

Selecting additional parameters will decrease the amount of time in which data can be recorded. Only select
parameters that are of interest to maximise recording time available.
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SUMMARY INTERVAL

Summaries provide an overview of what was recorded by the ShockLog in each time-period (the summary interval).
A summary records the number of warnings/alarms and the recorded maximum slot values in the summary
interval. The Summary Interval allows the user to set the time-period between each summary period.

Battery life is not affected by summary interval setting.

It is advisable to always select a summary interval that will last longer than the expected journey length.

JOURNEY DURATION
The Journey Duration button allows users to select the expected journey length, and the ShockLog will

automatically optimise the slot and summary intervals settings.

When considering journey length, it is important to consider when the ShockLog memory will be full and how long
the battery will last. The chart below will allow you to consider the best options for your summary intervals.

ShockLog ShockLog Interface
Summary ShockLog Satellite Module | Satellite Module Board ShockLog
Interval Memory Full* Internal External Battery
Battery Life Battery Life Battery
1 hour 42 days 3 months 60 days 12 months 12 months
2 hours 85 days 3 months 60 days 12 months 12 months
4 hours 170 days 6 months 75 days 12 months 12 months
8 hours 341 days 12 months 90 days 12 months 12 months
12 hours 512 days 18 months 90 days 12 months 12 months

*When the ShockLog memory is full, only alarms will be reported not summaries.

It is important to allow for potential delays during the journey or through customs. The journey duration should
always be set slightly longer than the expected journey length to prevent the possibility of not recording the end of
the journey.
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EVENTS

Impacts above the user-defined threshold are defined as events. The Events section allows the user to define the
criteria to be considered when recording a potentially damaging event.

¥, Setup - 208 =
| Firmware Options ;Seﬁings ESIots | Events ]F-S_I.c;{"ﬁ.larrns | T&;ﬁ:’-;darmsi Firish |
Record Thresholds
Length: 32 Kbytes + Mumber Events: |qpg Range ‘g’ or Velocity’ Hardware: Fitter
10g - 50 * Hz
Max. Time: 1 Sec + Sample Rate: |4096Hz
Options: Basic -
Always Mae. Auto Thresholds
[¥] Ordered Data [C] Enable »
Wam (%) |40 |2
) ssi Mewver )
Event Compression Aam (%) (50 12
Cortinue ==
RECORD

This section allows users to specify the resolution/memory to be allocated to each event. From the resolution and
memory setting, the number of recorded events is calculated by the software.

LENGTH

The more memory allocated to an event, the more points the event graph will display, and the higher the event
resolution will be. The ShockLog always records 4096 samples per second. However, the ShockLog will compress
saved data according to the how long the event is as defined by the event settings. The peak of an event will not
be lost when data is compressed as the ShockLog always keeps the max & min samples of each compressed
data section.

NOTE: Generally, it is desirable to log detailed events when damage may have occurred to the shipment. Settings
that allow for the maximum number of events are not always advisable. The user must determine if having fewer,
more detailed events or more events with less resolution is more desirable. Remember that a time slot graph
capturing the max peak in a time slot is produced for the entire journey.
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MAX TIME

The maximum length of any recorded event. All events are recorded for at least 1 second. The longer the event,
the more the data will be compressed. In certain situations, it may be desirable for the ShockLog to record the full
length of an event (potentially up to 128 seconds). If this is the case, the “Always Max” box must be selected. In

general, this setting is only used in a test environment, as most impact events are less than 1 second in duration.

Unless there is a specific reason to do so, do not use the Always Max setting. Let the ShockLog decide when the
event has finished by the dropout threshold. The dropout threshold is covered in the next section.

ORDERED DATA

Unless Always Max is selected, the ShockLog will record events in an uncompressed format displaying the full 4096
samples per second.

AUTO THRESHOLDS

Enabling this feature allows the unit to function in auto threshold mode. Select the desired reset time interval from
the dropdown menu. Thresholds are explained in the next section.

THRESHOLDS

This section is where unacceptable impact events are defined by acceleration level and filter frequency.

RANGE ‘G" OR "VELOCITY’

The range setting sets the maximum g-level to be recorded by the ShockLog. To set the ‘g’ range, click the drop-down
menu to view all the possible ranges (1, 3, 10, 30, 100 & 200). The ShockLog 298 has the ability to record in velocity;
this will automatically occur if a range in cm/s is selected. However, most users are interested in g-range.

NOTE: Selecting the range is a very important part of the ShockLog setup. Be aware of what impact levels are of
interest. Do not assume if the ShockLog is set to the 100g range everything will be recorded. In this scenario, the
resolution will be compromised and low-level events may not be recorded at all. The wake-up threshold for a
detailed event must be at least 5% of range (and recommended to be no less than 10%). On a 100g range, events
lower than 10g with a 10% wake up threshold will not be recorded.
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HARDWARE FILTER

After the range is selected, set the frequency cut-off of the hardware filters to be applied to the event data. These
filters enable users to reduce the number of unwanted higher frequency events where it is known that this type of
event will not cause damage to the object being monitored.

The lower the filter frequency, the more severe it is in eliminating events. The lower frequency filters are generally
used for large heavy objects with a high metallic content, especially where the object is prone to high levels of
resonance. These resonances will create a “bell-like” ring that a ShockLog can detect as a high g event if the
appropriate filters are not applied. Filters are recommended in environments where a high frequency vibration

is probable such as rail freight applications. The correct use of filters can eliminate any unwanted events being
recorded. If gRMS is to be recorded, the frequency filter must be set to 250Hz.

OPTIONS

The user selects one of four modes for the thresholds.

Basic — The default setting is “Basic.” The Warning level and the Alarm level can be adjusted by the user. The
wakeup and dropout levels are set automatically in the software based on the warning level selected.

Multiple — Allows the user to set all four thresholds (wake, warning, alarm, and dropout). The user is also able to
adjust the thresholds for each axis independently.

Link XYZ - All the axes operate off of the same thresholds.

Timed Events - Allows users to record a detailed event at the end of every summary period. This setting is not
dependent on thresholds being breached. Timed Events is an option for the ShockLog 298 only.

UNDERSTANDING THRESHOLD LEVELS

The threshold settings determine what level of impact will cause the ShockLog to wake up, the levels at which a warning
or alarm is created, and the dropout level of the event. The simple bar chart below can best explain these thresholds.

Alamm threshold

e
Waming threshald L

)
\ D Jorep outthechod
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It is not desirable for the ShockLog to constantly be awake due to low level vibration caused by the mode of
transport. The ShockLog uses 100 times more battery power when it is recording at higher resolutions than when
it is monitoring peak time slot values for wakeup thresholds. The ShockLog can easily see 0.5 to 1g of activity when
being transported in a car on normal roads.

If any accelerometer activity exceeds the wake-up threshold, the ShockLog will start recording accelerometer data
at a faster rate. The ShockLog takes 0.25 msec to start recording higher resolution data once the wake-up threshold
has been exceeded. If the activity does not exceed the warning level and drops below the wake-up threshold, the
ShockLog will go back to monitoring time slot peaks. An event will not be recorded.

When the wake-up threshold and the warning levels have been breached, the ShockLog will record a detailed event
and flag it as a warning. The same logic is applied when the alarm threshold level is breached. The ShockLog will
record a detailed event and flag it as an alarm.

Once the event activity has dropped below the drop out threshold (or reached the maximum allowed event length),
the ShockLog will stop the dynamic event recording and go back to monitoring peak values during time slots.

“WAKE”
The level at which the ShockLog will wake up and begin recording. The wake-up threshold should be set to
approximately 80% of the warning level.

It is not advisable to use wake-up or drop-out thresholds of less than 10%. However, it is possible to set levels down
to 5% if necessary.

“WARN AND ALARM”

Warning and alarm events are recorded in the same exact way. The thresholds distinguish how the events are
flagged in the ShockLog data file and how the LEDs on the ShockLog unit flash once a threshold has been breached.

Warning and alarm thresholds become more important when the ShockLog LEDs are to be used as part of a
shipment’s receiving audit. Example: Set a warning level to indicate the shipment should be quarantined pending
further investigation. Set the alarm threshold to indicate the shipment must be inspected without delay.

“DROP OUT”

The acceleration level at which the ShockLog will stop recording an event provided it has been set to record for
longer than 1 second and the “Always Max” box has not been selected. The drop out level should be no lower than
the wake-up threshold and can be as high as the warning.

If you are unsure of how to set your thresholds, please contact your local distributor or SpotSee Technical Support
for assistance.
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SLOT ALARMS

The Slot Alarms window allows the user to specify alarm settings depending on the factory options and
peripherals that have been specified in the Firmware Options tab.

. Setup - 208 = et S

gRMS (Vibration)
gRMS X (%) 75 |2 Enable [

gRMSY (i) (75 [ Enable [

aRMSZ(2) (75 [ Enable [ I

Environment

Low Limit Bxdemal RDZ99 HPT High Limt Extemal RDZ93 HPT
Tempersture (°F) |0 % Enable [T] Enable 0 & Enable [C] Enable

Humidty (%): |0 [ Enable [ Enable 0 |2l Enable [C] Enable
Dew Poirt (F) [0 | Enable [C] Enable

Enable Enable 0 Enable Enable

Continue == |

GRMS (VIBRATION)

gRMS alarms allow ShockLog 298 users to set slot alarms for gRMS data. In the setup window, users must select the
gRMS option (Firmware Options) for this measurement to be available.

Users should enable the axes for which a gRMS alarm is required and set the level as a percentage of the shock range.

(Not supported on ShockLog Satellite)

ENVIRONMENT

When temperature, humidity, and pressure sensors are to be used, the environment section allows users to set
low and high thresholds for these parameters. This section is where settings are made for both factory installed
temperature/humidity sensors or the external temperature/humidity/pressure sensor.

NOTE: To monitor temperature, humidity and pressure, please contact SpotSee Technical Support. Measurement of
these parameters would require an engineering modification to the ShockLog Satellite system.
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TILT & ROLL ALARMS

The T&R Alarm window is used when the Tilt & Roll option (internal) has been purchased as part of the ShockLog 298.

The external tilt and roll option should NOT be selected if using the ShockLog Satellite system as this accessory is
not supported by the ShockLog Satellite.

The alarms of interest should be enabled and the degree of tilt / roll should be entered by the user. Alarms can be
set for both upper and lower levels for tilt and roll.

rﬁ' Setup - 298 -I I._l_l_J':' . &1
i Firmware Options E Settings E Slots i Events ! Slot Alams I T&R Alarms rFmi )
Tilt and Roll :
Intemal @ Bxdemal

Titt Upper limit (degree): [0 2| Enable [7] 0 =| Enable
Roll Upperlimit {degree): 0 2| Enable [C] 0 | Enable
Titt Lower limit {degree): -2 2| Enable [C] 0 | Enable
Roll Lower limit {degree): -2 2| Enable [7] 0 =| Enable
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FINISH

The Finish window provides a summary of the settings and provides an opportunity to save the setup file and send it
to the ShockLog.

¥} Setup - 208 l = ﬂ—hj

| Firmware Options ISe‘t'lings ISIots I Everts I Slot Alarms I T&R Alarrnsl Firish |

S0 ™ I
Setup Mame: USA Trip
Start Date: 4/16/2013 9:23:21 AM
Accelerometers: Everts: Slots: Summaries:
Range 10 g Record Length 32K Interval 10 Sec Interval 10 Min
Wake (%) Acc.: 30 Max. Recond Time 1 Seconds Total run time 10Days 15Hours Total run time 7Days 2Hours
Wam (%) X:40 Y40 Z:40 Max. Mo. Events 108 Mene. Mo. Slots 53451
Alam (%) X:60 Y60 Z:60 Fiter Frequency $0Hz No. Contents set: 4
Dropout (%) ¥:40 Y40 Z:40 Always Max. MNo. Alams set: Mone Selected
Hardware filtter: 50 Hz
Standard Options Factory Options Peripherals RD401

SAVING SETUP FILE

After a setup has been defined, it must be saved before it can be sent to a ShockLog.
[l Click the disk save icon to save the file.

The system will automatically save the file in the default setup directory and can be retrieved for editing or sending to
a ShockLog at any time.
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SENDING SETUP TO SHOCKLOG

Once the setup has been created and saved, it can be sent to the ShockLog.

For easiest access, remove the ShockLog from the ShockLog Satellite case by removing the four mounting screws.
Remove the silver screw connector on the side of the ShockLog and Connect the ShockLog via the USB cable
to the PC and click the “Play” icon.

The status bar at the bottom of the screen will change to “OK” once the file has been successfully sent.

After the setup file has been sent to the ShockLog, the ShockLog should be returned to the ShockLog Satellite case
and secured with the four mounting screws.
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5. CONNECTING THE SHOCKLOG
RECORDER TO THE SATELLITE MODULE

The ShockLog Satellite satellite module and the ShockLog must be connected prior to use. A plug on the satellite
module covers the communication port between the module
and the ShockLog.

» .
1 - : - 1 -l .
OFF -

Prior to use, the satellite module will show OFF on the end of the module.

Unscrew the plug and remove.
Connect the black connector / cable to the communication port of the satellite module.

Keep the plug in a safe place as it will be used to turn the device off when not in use.
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6. MOUNTING

IMPORTANT: When mounting the ShockLog Satellite hardware, care must be taken to allow for line of sight to
the sky. Failure to do so will result in compromised satellite communication.

It is recommended that you mount the unit prior to starting it. This action prevents any impacts being recorded
that are a result of the mounting process.

Find a suitable mounting location on the asset with line of sight to the sky.

The ShockLog Satellite has x, y, and z axes noted on the unit. If the mounting of the ShockLog Satellite does not
allow you to match the axes of the unit, it is advisable to make a note of the exact mounting in order to correctly
analyze the reported impact values.

The ShockLog Satellite uses magnets for mounting. Grasp the unit in the positions noted by “Hold Here.” Position
two magnets in place and then carefully roll the last two magnets into position.

Magnetic mounts are intended for temporary mounting.

SAFETY WARNING

MAGNETIC FIELDS PRESENT
4 woiovere §

" ACAUTIO The mounting plate described in these instructions has a magnetic field. Do not
- locate near pacemakers or other equipment that is sensitive to magnets.

PINCH HAZARD
Mounting ShockTrak may cause injury to hands. Exercise caution to avoid pinching
hands and fingers when installing the mounting unit.

solutions@shockwatch.com.au 1300 074 625 shockwatch.com.au  Mar 2020



https://shockwatch.com.au

ShgckLog SH@CKWATCH °

Damage Prevention and Safety Solutions

7. START MONITORING

Once the ShockLog has been programmed and the ShockLog Satellite unit has been mounted, the unit must be
started to begin recording.

It is recommended that the START iButton be used to start the ShockLog Satellite. Remove
the black center cap from the ShockLog iButton port and insert the START iButton into the
port. When the iButton LED on the ShockLog is red and the Slot Alarm LED is green,
remove the iButton. The unit will start in one minute.

The ShockLog could also have been preprogrammed to start at a specific time. Refer to Configure the ShockLog
Satellite / ShockLog section of this manual for details.

Close the lid of the ShockLog Satellite system and secure the latches.

When an impact event occurs during the journey, an alert will

be sent through the web-hosted application and the ShockLog

LED Event Alarm will flash red every five (5) seconds for an

alarm condition and every ten (10) seconds for a warning condition.

31
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8. SPOTSEE PLATFORM

DASHBOARD

The SpotSee Cloud allows you to monitor the ShockLog Satellite from any location. After logging into the cloud
platform, the dashboard will show you the last known location of your ShockLog Satellite assets, a list of your active
assets and the most recent alarm for each asset.
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If multiple active assets are positioned in the same location, the Q Uritod

St

number of units in that location will be displayed. Z

Mexico

To examine the information for each individual ShockLog Satellite unit, click on the asset name in either the Active
Asset or Last Alarm Per Unit lists or click on the location icon on the map.
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ASSET PAGE

Once a ShockLog Satellite unit has been selected, more detailed information surrounding that unit will be displayed.

]

......

DATE RANGE

By default, the date range for a device in the SpotSee Cloud is the past seven (7) days. The date range is shown in the
top right portion of the screen. If a particular date range is of

interest, the range can be changed by selecting the calendar 5/24/2018 1:01 pm - 5/31/2018 1:01 pm —
icon shown to the right.

Clicking the calendar icon will open up a window where the user can set the date range as desired. Click the clock
icon, and a calendar will open for the user to select the date. Click Done when the date range has been set. Click
Update to set the date range.

The data from that particular date range will be in the dashboard view. Select Dot Rangs

NOTE: When large amounts of data are
being loaded, it will take a few minutes Select Date Range

for the data to render.
5/24/2018 1:01 pm © —

£/31/2018 1:01 pm Q)] e B =

Elem
=nl - B
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NOTIFICATIONS

When an alarm occurs, notifications can be sent to interested users. Click on the alarm icon to open the notifications
form. Enter the email address of the peson(s) who should receive notifications when an alarm occurs. Click the +
button to add additional users and the Update button after all email addresses have been entered.

5/24/2018 1:01 pm - 5/31/2018 1:01 pm Q —

Notifications >

Manage the email addresses you would like notified when an
ered below. You may select a current user or you

W emall aaaress.

LOCATION

The map will show the locations of the selected ShockLog Satellite. Alarm and summary location pins will be
clustered by proximity. Alarm pins will be displayed in red while summary pins will be displayed in blue. Pins
displayed with a number in them can be clicked and the map will zoom in until you can see individual pins. A red
heat map around the pins indicates that there is at least one alarm within that cluster.
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ALARMS/SUMMARIES

On the right side of the asset page is the list of alarms and summaries for Q f\lar'm onY —
the unit. The alarm shows the axis as well as the value recorded on the e AE

axis. Summaries show the total number of alarms reported. If the ShockLog

Satellite is in an area where it cannot communicate with the satellites, Q 32 ﬁ‘.ir_rﬂs.,..,, o

then the summary alarm count will alert users that an alarm has not been :

transmitted to the cloud and that the ShockLog should be downloaded at

the end of the journey for details regarding any missed alarms. Q ?' Aja:msa —

It is possible to turn off summaries (or alarms) from the cloud view. When

doing so, summaries (or alarms) will be removed from the map and the list. Q f—_ﬁ{i”"f]sv —

The trip path is traced by default in the SpotSee cloud. If you do not wish to

see the journey path, you may remove the Lines from the map. Q Alarm on Y v o

Click on the item at the bottom of the alarm list to turn parameters off or
on. The parameter that has been turned off will change to a gray colour.

Q 1 Alarm
Q 1 Alarm

Click to toggle items shown: Q Alarm Q Summary = Lines @ Alarm  Q Summary — Lines

It may be desirable to turn off summaries when loading large amounts of data as this will speed the load process.
However, you will no longer see all of the trip segments on the map.

UNIT INFORMATION TABLE

Below the map, a snapshot of information regarding the ShockLog Satellite is displayed. The Alarm Count summarizes
the number of alarms in the selected time range. The Time Since Last Message is a quick way to determine when the
last communication from the ShockLog Satellite has been. From this time, you can determine if a device has been
turned off or has a potential connectivity issue.

Alarm Count Tirne Since Last Message
3 1 wesk, 1 day, 1 hour, 19 minutes
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ALARMS OVER TIME
A graph of impact alarms over time is displayed. Each alarm is represented in the x, y, and/or z axis.

Alarms Over Time

Hover the cursor over the bars in the Alarms over Time graph to see the individual impact values.

Alarms Qver Time

IMPACT HISTOGRAM

Below the Impacts over Time graph, you will find the Impact Histogram. This graph will show you how many impacts
occurred over a certain impact threshold. The graph divides the impact values into bins. Each bar on the graph
represents the number times an impact occurred over a certain threshold.

In the example below, there was one impact 10G or less in the y-axis, two impacts of 10G or less in the z-axis and
two impacts between 11 and 20G in the y-axis.

Impacts Histogram
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OTHER PARAMETERS

The ShockLog Satellite will also record temperature, humidity and tilt & roll. Each parameter will have a value over
time graph associated with it.

The graph below illustrates temperature over time. Hover the cursor over the points in the chart to see the individual
temperature values.

@mperature Alarms Over Time

- K

CHANGE ASSET NAME

Devices in the cloud can be given names that are meaningful to the user. The asset name appears in the top left
portion of the screen. To change the name, click the pencil icon to open the Edit Asset form. Enter the desired asset
name and click update.

Cody Test #2 + ST e 8 L

Edit Asset X
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9. STOPPING THE SHOCKLOG SATELLITE

The ShockLog Satellite can be stopped with the Stop ibutton or it can be stopped after connecting the ShockLog to
a USB port. To prevent capturing impact events resulting from dismounting the ShockLog Satellite, a best practice is
to use the Stop ibutton.

Open the ShockLog Satellite case, remove the black plug from
the ibutton port.

Insert the STOP ibutton into the ibutton port. Button LED

All three LEDs will flash red every ten (10) seconds when
the unit has been stopped.

10. DOWNLOADING THE SHOCKLOG
SATELLITE

When the ShockLog Satellite system’s journey has ended, the full dataset from the ShockLog can be downloaded
through the USB port. This step is recommended if impact data needs additional analysis.

UNDERSTANDING THE STATUS LEDS

ShockLog units have three status LEDs that display the unit’s condition:

1. iButton
¢ Single colour LED (red)
¢ |lluminated when a valid iButton is inserted
¢ Used in conjunction with the SLOT ALARM LED, which flashes green when the iButton command is accepted

2. Slot Alarm
e Tri-colour LED (green, amber & red)
¢ Flashes every ten (10) seconds when in Waiting State, or every five (5) seconds when in Running State
¢ Condition
* No slot alarms - Flashes green
® One or more slot alarms - Flashes red

3. Event Alarm
e Tri-colour LED (green, amber & red)
¢ Flashes every ten (10) seconds when in Waiting State, or every five (5) seconds when in Running State

¢ Condition
* No events - Flashes green
e Warning event(s) recorded (with no Alarm events) - Flashes amber
e Alarm event recorded - Flashes red

For ShockLog units with firmware v27 and above, All LEDs flash red every ten (10) seconds when the unit is in the
Stopped state.
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USB CONNECTION

The ShockLog USB port is on the side of the ShockLog under
a silver screw connector. For easier access to the port, the
ShockLog can be removed from the ShockLog Satellite case.

In the ShockLog software, open the Communications
Window and connect the ShockLog through the USB to a PC.

The Communication Window information boxes
automatically update from the ShockLog.

The Communication window information includes the following parameters:

r Slot b L
Download | | Stat Send Setup | | Setup Pasawerds | Model: 230 Sedal Number: 23525 Vession: 21 Everts: Alams: 0 Wams: 0 ohoy Connection:  USB

[
L - Sum Mem @
[ SetClack | [ Sop | [ReadSetws | [ Secuiylog | Date/Teme: 12/16/20115:0055AM Range: 10 Stte:  Waiing Siot Mams: 0 FueriMem @  Puloenl  P400

Model Variant of the ShockLog attached i.e. ShockLog 298, 248, ShockLog RD298 or RD317. For
the ShockLog Satellite, the model will always be the 298.
Serial Number Serial number of the attached ShockLog.
Version Firmware code version of the attached ShockLog.
State Operating state of the ShockLog: Waiting, Running, or Stopped.
Connection Type of connection currently utilised to communicate with the ShockLog.
. Date and time set in the ShockLog unit; this field will update every 10 seconds while the
Date/Time .
unit is connected.
Range G range set in the attached unit.
m'&hut.kj_ug: Shocklog = [4/17/2014 1:34:34 PM 20036]
File Toels View | Windaws Help
« | Status bar
Setup Passwords and Security Log can be activated from the o
View menu at the top of the screen. Once activated the e 5’““"':“‘ ':‘“‘"" o |
| Passwor up Button '] =  Report Star: 4
buttons enable users to set up passwords and view the Securty Log View Prmwars Ve
. ers SecuiityLog Buiton Start Domricsd €
security log of the attached ShockLog. These capabilities are View Read Setup e [ Recerded T
Processed Data Staet £ e

described in more detail later in this manual. e = ey

- |— 416, 4
. -|_|— &O162004 2:22-27 PM20036
- 4162014 2:25-19 PM:20036
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11. RECOMMENDED STORAGE

When the unit is not in use, it is recommended that the ShockLog be stopped and the satellite module be turned off.

To turn off the satellite module, locate the satellite module in the ShockLog Satellite box and disconnect the
connector/cable.

Locate the plug and insert it into the connector such that the word OFF is visible. NOTE If the word ON is visible, you
will be powering the module and draining the battery

OFF

OnN

12. REDEPLOYING THE SHOCKLOG
SATELLITE

When the ShockLog Satellite is ready for another journey, the ShockLog should be reprogrammed for the new
journey. When a new setup is sent to the ShockLog, all existing data is deleted from the device. Refer to Creating a
Setup section for instructions on creating a new setup.

solutions@shockwatch.com.au 1300 074 625 shockwatch.com.au



https://shockwatch.com.au

SHOECKWATICH®

E Damage Prevention and Safety Solutions
A

-

13. TECHNICAL SUPPORT / CUSTOMER
SUPPORT CONTACTS

If at any time you need assistance with the ShockLog Satellite or ShockLog, please get in touch with us.

Email: solutions@shockwatch.com.au
Call: 1300074 625
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